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本文件供已购买 SCIEX 设备的客户在操作此 SCIEX 设备时使用。本文件受版权保护，除非 SCIEX 书
面授权，否则严禁对本文件或本文件任何部分进行任何形式的复制。

本文中所介绍的软件依据许可协议提供。除许可证协议中特别准许的情况外，在任何媒介上复制、修改
或传播本软件均为违法行为。此外，许可协议禁止出于任何目的对本软件进行分解、逆向工程或反编
译。质保条款见文中所述。

本文件的部分内容可能涉及到其他制造商和/或其产品，其中可能有一些部件的名称属于各自所有者的注
册商标和/或起到商标的作用。这些内容的使用仅仅是为了表明这些制造商的产品由 SCIEX 提供以用于
整合到 SCIEX 的设备中，并不意味 SCIEX 有权和/或许可来使用或允许他人使用这些制造商的产品和/
或允许他人将制造商产品名称作为商标来进行使用。

SCIEX 的质量保证仅限于在销售或为其产品发放许可证时所提供的明确保证，而且是 SCIEX 的唯一且
独有的表述、保证和义务。SCIEX 不作任何其他形式的明确或隐含的质量保证，包括但不限于特定目的
的适销性或适用性的保证，不论是法规或法律所规定、还是源于由贸易洽谈或商业惯例，对所有这些要
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操作注意事项和限制 1
注释: 在运行系统之前，请仔细阅读本指南的所有部分。

本部分包含与安全相关的一般信息，并介绍了法规遵从性信息。此外，还描述了系统的潜在危
险和相关警告，以及为尽量减少危害而应当采取的预防措施。

除了本部分之外，如需了解与实验室环境、系统和本文档中所用符号相关的信息，请参阅以下
章节：符号词汇表。有关场地要求，请参阅文档：《场地规划指南》。

一般安全信息
为避免人身伤害或系统损坏，请阅读、了解并遵守本文件、制造商化学品安全数据表 (SDS)
以及产品标签信息中的所有安全预防措施和警告。这些标签使用国际公认的符号表示。如果未
能注意这些警告可能会导致严重的伤害。

此安全信息的目的是补充联邦、州、省和当地的环境健康和安全 (EHS) 法规。它不包括应实
行的各项安全程序。因此，用户和组织有责任遵守联邦、州、省和当地的环境健康和安全法
规，维护安全的实验室环境。

请参阅正确的实验室参考材料和标准操作程序。

文档标志和惯例
本指南采用了以下标志和惯例。

危险! 危险表示会导致重伤或死亡的行为。

警告! 警告表示如不遵守注意事项可能会导致人身伤害的行为。

小心: 表示如不遵守注意事项可能会导致系统受损或数据破坏或丢失的操作。

注释: 注释一词突出强调了程序或说明中的重要信息。

提示! 提示在文中针对特定需求提供有助于应用技术和程序的有用信息，以及提供捷径，但对
于程序的完成而言并非必不可少。

合规性
本系统符合本节所列法规和标准。关于注明日期的参考资源，请参阅包含在系统和单个系统组
件中的合规声明。系统上已粘贴适用标签。

操作注意事项和限制
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澳大利亚和新西兰

• 电磁兼容性 (EMC)：如在以下这些标准中执行的无线电通讯法案 1992：

• 电磁干扰－AS/NZS CISPR 11/ EN 55011/ CISPR 11（A 类）。请参阅以下章节：电磁
干扰。

加拿大

• 电磁干扰 (EMI)：CAN/CSA CISPR11。本 ISM 设备符合加拿大 ICES-001。请参阅以下章
节：电磁干扰。

• 安全性：

• CAN/CSA C22.2 No.61010-1

欧洲

• 电磁兼容性 (EMC)：如在以下这些标准中执行的电磁兼容性指令 2014/30/EU：

• EN 61326-1

• EN 55011（A 类）

请参阅以下章节：电磁兼容性。

• 安全性：如在以下这些标准中执行的机械指令 2006/42/EC：

• EN 61010-1

• 废旧电子电气设备 (WEEE)：如在 EN 40519 中执行的废旧电子电气设备指令 2012/96/
EEC。请参阅以下章节：废弃电子电气设备。

• 包装与包装废弃物 (PPW)：包装与包装废弃物指令 94/62/EC

• 关于限制在电子电气设备中使用某些有害成分的指令 (RoHS)： RoHS 指令 2011/65/EU 和
2015/863/EU

美国

• 无线电发射干扰条例： 47 CFR 15，在 FCC Part 15 (A 类) 标准中实行

• 安全性： 职业安全和健康条例－29 CFR 1910，在这些标准中实行：

• UL 61010-1

国际

• 电磁兼容性 (EMC)：

• IEC 61326-1

• IEC CISPR 11（A 类）

请参阅以下章节：电磁兼容性。

• 安全性：

操作注意事项和限制
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• IEC 61010-1

电气注意事项

警告! 触电危险。切勿拆除保护盖。拆除保护盖可能会导致人员受伤或系统故障。
进行例行维护、检查或调整时不需要拆下保护盖。当修理需拆下主盖时，请与
SCIEX 现场服务人员 (FSE) 联系。

• 遵循所要求的电气安全工作实践。

• 按照电缆管理实践控制电气电缆。这将会降低绊倒危险发生的可能性。

有关系统电气规格的信息，请参阅文档：《场地规划指南》。

主电源

按照本指南的说明将系统连接到兼容的主电源。

警告! 触电危险。所有电气线路和固定装置只能由专业人员负责安装，并确保所
有安装均遵循当地法规和安全标准。

警告! 触电危险。仅使用随系统提供的主电源电缆。请勿使用未为本系统运行而
进行适当评级的主电源电缆。

警告! 触电危险。确保在紧急情况下，可通过断开系统背面主电源入口的主电源
线来断开系统与主电源的连接。请不要阻塞系统的背面。

保护接地导体

主电源必须包括正确安装的保护接地导体。在连接本系统前，必须由合格的电气技师安装或检
查保护接地导体。

警告! 触电危险。不要故意断开保护接地导体。任一保护接地导体断开都将造成
触电危险。

化学品注意事项

警告! 电离辐射危险、生物危害或有毒化学品危险。在清洁或维护质谱仪之前，
确定是否需要去污。如果系统使用了放射性物质、生物制剂或有毒化学品，则
在清洁或维护之前客户必须先消除系统污染。

警告! 环境危害。请勿按照城市垃圾处置方式来处置系统组件。处理组件时，请遵
循当地法规。

操作注意事项和限制
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• 在维修和定期维护前，确定系统中已经使用了哪些化学品。有关必须遵守的化学品健康和
安全注意事项，请参阅安全数据表 (SDS)。有关存储信息，请参阅分析证书。要查找
SCIEX 安全数据表或分析证书，请转到 sciex.com/tech-regulatory。

• 一定要穿指定的个人防护设备，包括无粉手套、防护眼镜和实验室外套。

注释: 建议使用丁腈或氯丁橡胶手套。

• 在通风良好的区域或通风橱内工作。

• 当工作中用到易燃材料，如异丙醇、甲醇和其他易燃溶剂时，请避免火源。

• 要小心地使用和处置任何化学品。如果不遵循处理和处置化学品的适当程序，就会存在人
身伤害的潜在风险。

• 清洗过程中应避免皮肤接触化学品，使用后洗手。

• 收集所有废液并将其按有害废弃物处置。

• 请遵守关于生物危害性、有毒和放射性物质的存储、处理和处置的所有当地法规。

系统安全液体

小心: 潜在的系统损坏。在收到 SCIEX 确认液体不会造成危害的通知之前，不得使用任何其他
液体。这不是一份详尽的清单。

小心: 潜在的系统损坏。切勿使用甲醇或丙酮等有机溶剂清洁毛细管窗口。有机溶剂会溶解胶
粘剂，毛细管窗口的残留物可能会影响检测器。

BioPhase 8800 分析试剂盒中的任何物质，或在《BioPhase 8800 系统应用指南》中引用的任
何物质，都可以安全地用于系统。此外，下列液体也可以在系统中使用。要确定与其他化学物
质的兼容性，请联系 sciex.com/request-support。

• 酸和碱

pH 范围从 2 到 12。

• 乙酸，最高 10%

• 氢氧化钠，最高 1 M

• 盐酸，最高 1 M

• 试剂

• CE Grade Water

物理注意事项

警告! 抬升危险。使用机械起重装置来抬升和移动系统。如果必须手动移动系统，则至
少需要四个人才能安全地移动系统。请遵照既定安全抬升操作规程。我们推荐使用专
业的移动服务。

操作注意事项和限制
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环境注意事项
安排合格的人员安装主电源、加热、通风和上下水管线及固定装置。确保所有的安装均符合当
地规章和生物危害法规。有关该系统所需环境条件的信息，请参阅文档：《场地规划指南》。

设置系统时可以在设备周围预留接入空间。

警告! 生物危害。使用生物危害性物质，一定要遵守危害评估、管控和处理方面的当地
法规。本系统或其任何部分不得作为生物屏障使用。

警告! 环境危害。遵照既定程序处置生物危害性、有毒、放射性和电子废弃物。客
户负责按照当地法律和法规处置有害物质，包括化学品、废油和电气部件。

电磁环境
电磁兼容性

基本电磁环境：具有直接从公共电网低压供电特征的地点所存在的环境。

本设备拟用于基本电磁环境。

确保可为设备维持可兼容的电磁环境，使该设备按预期运行。如果电源线具有较高电气噪声，
则安装电涌保护器。

电磁干扰

第 1 组设备：此类设备分类为工业、科学和医疗 (ISM) 设备，其内部运行可能使用射频能量。

A 类设备：适用于除住宅及直接与为住宅供电所用低压电源网络相连的所有设施的设备。[摘
自 CISPR 11:2009, 5.3] A 类设备应遵守 A 类限制。

小心: 潜在的无线电干扰。本设备不适用于居住环境，可能无法在此类环境中提供足够的无线
电接收保护。

根据 FCC（美国联邦通信委员会）合规规则第 15 部分的规定，本设备已经进行了测试，证明
符合 A 类数字设备的限制。

这些限制旨在提供合理的保护，防止本设备在商业环境中运行时受到有害干扰。本设备会产
生、使用并可能辐射无线频率能量，如果未按照操作手册要求安装和使用，可能会对无线通信
造成有害干扰。

在住宅区使用本设备可能会造成有害干扰，在这种情况下，消除此类干扰的费用需自行承担。
未得到制造商明确批准的变更或修改可能会使您操作本设备的权限失效。

拆除和处置

警告! 环境危害。遵照既定程序处置生物危害性、有毒、放射性和电子废弃物。客
户负责按照当地法律和法规处置有害物质，包括化学品、废油和电气部件。

拆除前，请按当地法规对整套系统进行去污处理。

当弃用系统后，根据国家和当地环境法规条例分离和回收不同材料。

操作注意事项和限制
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注释: SCIEX 不会接受未填写净化表的任何系统回收。请联系现场服务人员获得一份净化表。

不要将系统组件或部件（包括计算机部件）作为未分类的城市废弃物进行处理。

废弃电子电气设备

遵循当地城市废物法规条例中的合适处理规定，减少废弃电子电气设备 (WEEE) 对环境的影
响。为了安全地处理设备，请联系当地的客户服务部进行免费的仪器上门回收。

紫外线辐射预防措施

警告! 紫外线辐射危险。避免暴露在直接的或反射的紫外线辐射中。紫外线辐射对眼睛
和皮肤有害。在没有所需的系统安全联锁装置的情况下，不要操作紫外线源。

激光注意事项
本部分适用于配有激光诱导荧光 (LIF) 检测系统的系统。

警告! 激光危害。遵循适用于激光安全的所有当地法规、规程、标准和内部要求。

警告! 激光危害。使用设备和控制装置或者执行程序时，务必按照本指南中记录的方式
进行。否则可能会接触到有害的激光辐射。

警告! 人身伤害危险。不要直视激光束的预期路径或激光束的任何镜面反射。激光发出
的不可见紫外线辐射会对眼睛造成伤害。

警告! 人身伤害危险。不要拆下激光设备组件的外罩。如果没有外罩，则人员可能会暴
露在有潜在危害的激光辐射中。

LIF 检测系统在密封模块中包含 I 类激光系统。该模块包含内嵌“3B 类”激光组件。3B 分类意味
着直接迎着光束凝视此类激光始终会对人员造成危害。

激光总成包含位于密封壳体内的激光器和其他几个组件，没有用户可维修的部件。激光总成的
维修仅限由具备资质的 SCIEX 现场服务人员 (FSE) 实施。因此，系统的整体激光分类为
1 类，定义为在可合理预见的工作条件下安全的激光器。

合格人员
只有合格的 SCIEX 员工才能安装、检查和维修本设备。安装完系统后，现场服务人员 (FSE)
会使用 Installation Qualification（客户熟悉系统检查清单）指导客户熟悉系统操作、清洁和基
本维护。如果系统曾由非 SCIEX 授权人员维修，则 SCIEX 可能无法对系统损坏进行保修范围
内的承保。

操作注意事项和限制
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实验室条件

安全环境条件

系统设计为可在以下条件下安全操作：

• 室内

• 海拔高度：最高 2,000 m（6,560 英尺）

• 环境温度：15 °C (59 °F) 到 40 °C (104 °F)

• 相对湿度：20% 至 80%，无凝结

• 主电源电压波动：标称电压的 ± 10%

• 瞬态过电压：最高可达到过电压类别 II 的级别

• 主电源暂时过电压

• 污染程度 2

性能规范

系统设计为在以下条件下符合规范：

• 环境温度为 15 °C 至 30 °C（59 °F 至 86 °F）

温度随时间的变化必须保持在 4 °C (7.2 °F) 范围内，温度的变化率为每小时不超过 2 °C
(3.6 °F)。若环境温度波动超出限制，可能会导致迁移时间偏移。

• 相对湿度为 30% 至 70%，无凝结。

设备使用和修改

警告! 触电危险。切勿拆除保护盖。拆除保护盖可能会导致人员受伤或系统故障。
进行例行维护、检查或调整时不需要拆下保护盖。当修理需拆下主盖时，请与
SCIEX 现场服务人员 (FSE) 联系。

警告! 人身伤害危险。只能使用 SCIEX 推荐的部件。使用非 SCIEX 推荐使用的部件或
者将部件用于任何非设计用途，可能会对用户造成伤害，或对系统性能带来不利影响。

警告! 抬升危险。使用机械起重装置来抬升和移动系统。如果必须手动移动系统，则至
少需要四个人才能安全地移动系统。请遵照既定安全抬升操作规程。我们推荐使用专
业的移动服务。

请在符合《场地规划指南》建议环境条件的实验室内使用该系统，或联系 FSE。

如果系统的使用环境或使用方式不符合制造商规定，那么设备提供的性能和保护可能会受到影
响。

操作注意事项和限制
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有关系统的维修信息，请联系现场服务人员。对系统进行未经授权的修改或操作可能会导致人
身伤害和设备损坏，且可能会导致保修失效。在超出建议环境条件时或在经未经授权的修改后
运行系统，可能会生成错误数据。

操作注意事项和限制
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简介 2
本指南介绍了 BioPhase 8800 系统的基本操作、故障排除和维护。使用产品之前应当通读本
指南，并按照本指南中的说明操作产品。

本指南中提供了安全说明和预防措施，以确保用户安全地操作系统。遵守本指南中提供的所有
“警告”和“小心”说明。

描述
BioPhase 8800 系统是一种八通道毛细管电泳系统，能够对多达 96 份样本执行分离而无需用
户介入。

BioPhase 8800 系统包括下列组件：

• 前面板上的触摸屏

• UV 源和检测器

• （可选）488 nm 激光器和 LIF 检测系统

• 用于控制系统和执行数据采集的软件，包括：

• BioPhase 软件。作为进行数据分析的应用程序，BioPhase Analysis 软件包含在
BioPhase 软件中，

• BioPhase 8800 driver for Empower™。使用 BioPhase 8800 driver for Empower™ 采集
的数据不能使用 BioPhase Analysis 软件进行数据分析。

系统使用预装卡盒，其中包含八支无涂层熔融石英毛细管或八支中性毛细管。

SCIEX 提供了分析试剂盒，专门设计为与 BioPhase 8800 系统配合使用。这些试剂盒包含试
剂、样本以及试剂孔板。

相关文档
本文档假定读者对 Waters Empower™ 软件有一定的了解。如需关于 Waters Empower™ 软件
的一般功能的说明：

• 请参阅软件随附的文档。

• 在 Empower Start 对话框中单击 

• 单击 Help（在任何 Waters Empower™ 软件窗口中）。

有关将 Waters Empower™ 软件用于特定毛细管电泳应用的详细说明，请参阅以下应用指南：

• 毛细管等电聚焦 (cIEF) 分析应用指南

• CE-SDS 蛋白质试剂盒应用指南

• RNA 9000 Purity & Integrity 试剂盒应用指南

简介
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Waters Empower™ 软件术语（面向 BioPhase 软
件用户）
结合使用 BioPhase 8800 系统与 BioPhase 软件的用户必须熟悉 Waters Empower™ 软件术
语。

表 2-1 Waters Empower™ 软件术语（面向 BioPhase 软件用户）

BioPhase 软件术语 Waters Empower™ 软件
等效项

描述

在 BioPhase 软件中无等
效项

仪器方法 包含数据采集所需的系统参数的方法。
参数按照通用参数、检测器参数和时间
程序的类别进行分组。

处理方法 包含数据处理参数的方法。

报告方法 用于创建显示处理方法结果的报告的方
法。

方法 方法集 仪器方法、处理方法和报告方法的组
合。处理方法和报告方法是可选项。

序列 样本组方法 用于发送到 BioPhase 8800 系统以进
行数据采集的样本和相关方法集的列
表。或者，Waters Empower™ 软件也
可进行采集后数据处理并生成报告。

报告 报告 包含数据采集结果的相关信息的文件。
报告还可包含生成数据的组织的相关信
息。报告的布局和外观可进行定制，并
保存为报告模板的一部分。

样本入口孔板 孔板 容纳待分析样本的 96 孔板。

样本出口孔板 孔板 包含分离所需凝胶或缓冲剂的 8 槽孔
板。

试剂入口孔板 孔板 容纳试剂和冲洗液的 96 孔板。

试剂出口孔板 孔板 用于收集毛细管废液的 8 槽孔板。

计算机 LAC/E 模块 控制 BioPhase 8800 系统的计算机。

简介
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硬件概述

图 2-1 前面板和侧面板，孔板室已打开

项目 描述

1 前面板

2 电源按钮

3 孔板室，门已打开

4 光室门

简介
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图 2-2 后面板

项目 描述

1 主电源连接点和保险丝座

2 RJ-45 网络连接器

简介
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卡盒

图 2-3 卡盒正面

项目 描述

1 手柄

2 序列号标签

3 毛细管入口

4 毛细管出口

5 喷针

6 毛细管窗口和小孔

简介

BioPhase 8800 系统 适用于 BioPhase 8800 Driver for
Empower™ 用户
18/103

操作员指南
RUO-IDV-05-15014-ZH-A



图 2-4 卡盒背面

项目 描述

1 毛细管窗口和小孔

2 压力出口端口

3 冷冻剂出口端口

4 喷针

5 毛细管出口

6 冷冻剂入口端口

7 毛细管入口（从左到右为毛细管 A 到 H）

8 压力入口端口

9 ID 芯片

10 手柄

可用卡盒

BioPhase 8800 卡盒配有八根毛细管，其配置如下：

• 50 µm 内径 × 30 cm 无涂层熔融石英毛细管

• 50 µm 内径 × 30 cm 中性毛细管

简介
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样本孔板

BioPhase 8800 系统使用 96 孔样本孔板。

要配置孔板以在自动液体处理系统中使用，请参阅以下章节：孔板规格。

图 2-5 样本孔板

项目 描述

1 对准槽口

2 倒角

试剂孔板

要配置孔板以在自动液体处理系统中使用，请参阅以下章节：孔板规格。

简介
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图 2-6 试剂孔板

项目 描述

1 对准槽口

2 倒角

出口孔板

要配置孔板以在自动液体处理系统中使用，请参阅以下章节：孔板规格。

图 2-7 出口孔板

项目 描述

1 试剂孔

2 溢流孔，留空
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项目 描述

3 倒角

工作原理
毛细管电泳 (CE) 是一种对样本成分进行分离和定量的技术。在 CE 方法中，分析物在电场的
影响下通过电解质溶液迁移。分析物可以根据淌度进行分离，也可以通过非共价相互作用划分
为替代相。此外，分析物可利用电导率或 pH 梯度浓缩或聚焦。

BioPhase 8800 系统上的数据采集利用 BioPhase 8800 driver for Empower™ 结合 Waters
Empower™ 软件启用。Method Editors for BioPhase System 软件是 BioPhase 8800 driver for
Empower™ 的一部分，用于开发仪器方法和样本组方法。

UV 检测系统

UV 检测系统包括紫外光源、波长滤波器和光电二极管检测器。

UV 源是波长范围为 190 nm 至 400 nm 的氘灯。两个透镜聚焦灯的输出并引导其穿过其中一
个波长选择滤波器。光束继续穿过卡盒中的小孔，然后穿过检测窗口，该窗口是毛细管上经过
处理除去了聚酰亚胺涂层的一段。传送的光束继续通过光电二极管。光信号转换成电信号，经
过数字化处理后发送到软件进行处理。

滤波器底座上有可以容纳两个滤波器的空间。BioPhase 8800 系统发货时随附两个 25 nm 带
宽滤波器：220 nm 和 280 nm。

激光诱导荧光 (LIF) 检测系统

LIF 检测系统是可选组件。

LIF 检测系统使用固态 488 nm 激光源。激发光从激光器传送到卡盒中的毛细管。检测毛细管
中在激光波长下可发出荧光的物质。LIF 检测器测量并记录此荧光，它在电泳图谱上显示为
峰。仪器随附有 520 nm 发射滤波器。

BioPhase 8800 系统与 Waters Empower™ 软件之间的交互

BioPhase 8800 系统使用含有八支毛细管的卡盒。分离将在八支毛细管中同时发生。

为了执行分离并随后保存分离数据，Waters Empower™ 软件使用 BioPhase 8800 driver for
Empower™。当运行开始时，该驱动程序使用 Empower 功能对所有八支毛细管启动分离。然
后，BioPhase 8800 系统执行分离。八支毛细管的进度状态以及所采集的数据可在 Waters
Empower™ 软件的 Trace View 窗口查看。

来自所有八支毛细管的数据都发送给 Waters Empower™ 软件采集服务器上的驱动程序。驱动
程序保存来自毛细管的数据，每次一支毛细管，或者启动新运行。请参阅以下章节：新运行的
原因。总之，分离是同时进行的，但数据则是每次一支毛细管地保存到 Empower 数据库的。

此程序与使用 Waters Empower™ 软件进行的单样本进样不同，后者通常用于液相色谱法，在
进样开始时就开始将数据保存到 Empower 数据库。

简介
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Waters Empower™ 软件的处理速度和网络速度控制保存数据所需的时间长度。在网络速度较
慢的情况下，分离结束时间与数据保存到 Empower 数据库的时间之间可能存在间隔。在
Waters Empower™ 软件 Project 窗口的 Injections、Channels、Results 和其他选项卡中，
Date Acquired 字段会显示保存数据的时间。其结果是，即使数据同时采集，Date Acquired 字
段中的值也会存在差异。这与 Waters Empower™ 软件中的 Date Acquired 字段的设计和功能
一致。

如果运行被用户停止，分离结束时间与数据保存时间之间的间隔会受到影响。请参阅以下章
节：停止运行。

停止运行

当样本组方法正在运行且系统处于忙碌状态时，不允许执行来自 BioPhase 8800 driver for
Empower™ Direct Control 窗格的操作。如果 BioPhase 8800 driver for Empower™ 正在保存数
据且系统为闲置状态，则 Direct Control 操作可用，但不应使用。

小心: 潜在的数据丢失。切勿在运行期间从 BioPhase 8800 driver for Empower™ Direct
Control 窗格发起任何操作，即使系统处于闲置状态也不例外。任何操作都可能会干扰数据采
集。

如果需要在完成之前停止运行，则已保存到数据库中的数据只包含从第二行到最后一行红色文
字的样本。不会保存当来自当前行（红色文字）的数据。为了确保所有必需数据都得到保存，
请执行以下操作之一：

• 让样本组方法完成。当方法完成时，Abort 按钮 ( ) 从红色变成绿色 ( )。

• 等到所需样本的数据保存完毕并开始下一个进样，然后停止运行。

打开系统并登录
1. 按下系统正面的电源按钮。

简介
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图 2-8 Instrument Locked 窗口

2. 在前面板上，触摸屏幕以解锁系统并查看前面板登录屏幕。

3. 触摸 Log In。

注释: 如果 Username 字段为空，则键入 Empower。
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图 2-9 前面板登录
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BioPhase 8800 系统前面板 3
本部分介绍在 BioPhase 8800 系统前面板主页中可用的功能区、状态面板和功能。

图 3-1 前面板主页

BioPhase 8800 系统前面板

BioPhase 8800 系统 适用于 BioPhase 8800 Driver for
Empower™ 用户
26/103

操作员指南
RUO-IDV-05-15014-ZH-A



前面板：功能区

图 3-2 功能区功能

项目 描述

1 触摸以查看光源使用和软件版本的详细信息，以及关闭仪器电源。

2 触摸以查看主页。

3 触摸以查看直接控制功能。

4 触摸以查看日志。

5 显示卡盒状态。

注释: 装载卡盒后图标变成绿色。

6 触摸以将卡盒状态更改为 LOADED 或 EJECTED。

7 触摸以将紫外线灯设为 ON 或 OFF。

注释: 灯打开之后，计时器将开始 30 分钟的倒计时，指示灯准备就绪之前需要
经过的时间。

8 触摸以将 LIF 激光器设为 ON 或 OFF。

注释: 激光器打开之后，计时器将开始 15 分钟的倒计时，指示灯准备就绪之前
需要经过的时间。如果仪器上未安装 LIF 检测系统，则 LIF 激光器按钮不可
用。

前面板：状态
前面板底部的状态面板显示系统信息和状态。

BioPhase 8800 系统前面板
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图 3-3 前面板状态

项目 描述

System Status

显示系统状态。

Action Progress

显示当前样本组方法的进度状态。

Method

显示仪器方法名称。

显示样本存储温度。

显示卡盒温度。

显示压力。

显示毛细管的电压。

显示毛细管的电流。

显示检测器类型。

BioPhase 8800 系统前面板
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项目 描述

显示冷冻剂液位。

注释: 绿色表示可接受的液位，黄色表示液位较低，红色表示冷冻剂已
空。如果图标为红色，系统将不会运行。

指示在运行过程中发生的错误。

指示 Waters Empower™ 软件正在控制的系统。

触摸以锁定前面板触摸屏。

触摸以注销。

触摸以停止系统。

如果样本组正在运行，则在 Waters Empower™ 软件的 Run Samples 窗

口中，单击  (Abort)。

显示当前时间和日期。

前面板功能

图 3-4 前面板主页按钮

BioPhase 8800 系统前面板
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项目 描述

Direct Control 触摸以查看用于仪器手动操作的选项。请参阅以下章节：直接控制。

其他功能可从 BioPhase 8800 driver for Empower™ 获得。请参阅以
下章节：Waters Empower™ 软件中的直接控制。

Log 触摸以查看前面板日志。请参阅以下章节： 日志。

直接控制

本部分介绍 BioPhase 8800 系统前面板上的直接控制功能。

图 3-5 Direct Control 窗口

图 3-6 信息

BioPhase 8800 系统前面板
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表 3-1 直接控制功能

项目 描述

触摸以查看或编辑温度参数。请参阅以下章节：设置温度。

触摸以查看或编辑波长设置参数。请参阅以下章节：波长设
置。

触摸以弹出样本孔板。请参阅以下章节：加载或弹出孔板。

触摸以弹出试剂孔板。请参阅以下章节：加载或弹出孔板。

触摸以将试剂和样本孔板移动到初始位置。请参阅以下章节：
输送复位。

设置温度

使用 Set Temperature 部分调整样本存储和毛细管卡盒的温度。

BioPhase 8800 系统前面板
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图 3-7 设置温度

标签 描述

< Back 触摸以返回 Direct Control 窗口。

Sample Storage
Temperature

触摸以设置 4 °C 至 37 °C 的温度值。实际温度显示在右侧，
单位为 °C。

Capillary Cartridge
Temperature

触摸以设置 15 °C 至 40 °C 的温度值。实际温度显示在右侧，
单位为 °C。

Accept 触摸以接受所有更改。

波长设置

使用 Wavelength Settings 部分设置 UV 和 LIF 滤波器波长。用户还可以更换紫外线灯、UV
滤波器和 LIF 滤波器。

BioPhase 8800 系统前面板
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图 3-8 UV Wavelength

标签 描述

< Back 触摸以返回 Direct Control 窗口。

UV Filter 1

Filter Wavelength 触摸以设置滤波器波长值，范围为 200 nm 至 400 nm。

Serial Number 触摸以设置序列号。

UV Filter 2

Filter Wavelength 触摸以设置波长值，范围为 200 nm 至 400 nm。

Serial Number 触摸以设置序列号。

Done 完成操作后，触摸 Done 以返回 Direct Control 窗口。

Replace Filter 请参阅以下章节：安装 UV 滤波器。

Replace UV Lamp 请参阅以下章节：安装紫外线灯。

BioPhase 8800 系统前面板
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图 3-9 LIF Wavelength

标签 描述

< Back 触摸以返回 Direct Control 窗口。

Excitation Wavelength

Wavelength 波长从系统上的激光器获得。

Emission Wavelength

Filter Wavelength 触摸以设置 300 nm 至 700 nm 的波长。

Serial Number 触摸以设置序列号。

Done 完成操作后，触摸 Done 以返回 Direct Control 窗口。

Replace Filter 请参阅以下章节：安装 LIF 检测器滤波器。

加载或弹出孔板

从 Direct Control 窗口中，用户可以加载或弹出样本和试剂孔板。

图 3-10 Load or Eject the Plates

标签 描述

Eject/Load Reagent 触摸以加载或弹出试剂孔板。

BioPhase 8800 系统前面板
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标签 描述

Eject/Load Sample 触摸以加载或弹出样本孔板。

注释: 当未安装孔板时图标显示向下箭头，而在安装了孔板时自动变成向上箭头。

输送复位

使用 Transport Home 按钮将试剂和样本孔板移动到初始位置。触摸 Transport Home 以将试
剂孔板移动到初始位置（列 1），样本孔板移动到存储位置。

图 3-11 试剂托盘位置

日志
本部分介绍前面板日志功能。

BioPhase 8800 系统前面板
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图 3-12 前面板 Events 选项卡

标签 描述

Initialize System 触摸以初始化前面板系统。

注释: 如果在运行期间出错，前面板状态区域会显示红色感叹
号。要重新初始化系统，触摸 Initialize System。

触摸以删除日志消息。

BioPhase 8800 系统前面板
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图 3-13 前面板 System 选项卡

配置用于 BioPhase 8800 Driver for Empower™

的系统
默认情况下，BioPhase 8800 系统已配置为与 BioPhase 软件一起使用。使用下列步骤配置用
于 BioPhase 8800 Driver for Empower™ 的系统。

注释: 下面提供的用户名和密码是默认设置。它们可能已更改。

1. 在 BioPhase 8800 系统前面板上，从 Login 对话框：

a. 在 Username 字段中，键入 admin。
b. 在 Passcode 字段中，键入 password。
c. 触摸 Log In。

2. 触摸 Configuration。

3. 触摸 Network。

4. 在 Project Management 部分，执行以下操作。

a. 选中 Enable Third-Party Control 复选框。

b. 在 Third-Party Control 列表中，选择 Empower。

c. 触摸 Save。

5. 在 BioPhase 8800 部分，执行以下操作。

a. 在 IP Address 字段中，键入系统的 IP 地址。

使用在 Waters Empower™ 软件中配置节点时所使用的相同 IP 地址。请参阅文档《版
本发布说明》中的“配置节点”章节。

b. 在 Subnet Mask 字段中，键入 255.255.255.0。

BioPhase 8800 系统前面板
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c. 触摸 Save。

图 3-14 BioPhase 8800 Driver for Empower™ 的网络设置

6. 关闭，然后重新打开 BioPhase 8800 系统。

a. 在触摸屏左上角，触摸系统图标。

图 3-15 BioPhase 8800 系统图标

b. 触摸 Power Off。

c. 按下系统正面的电源按钮。

BioPhase 8800 系统前面板
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Waters Empower™ 软件中的直接控制 4
直接控制状态和按钮
Direct Control 窗格底部的状态面板显示系统信息和状态。

图 4-1 BioPhase 8800 Driver for Empower™ Direct Control 窗格

图 4-2 Direct Control 状态面板

项目 描述

状态图标

显示样本存储温度。

显示卡盒温度。

显示压力。

Waters Empower™ 软件中的直接控制
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项目 描述

显示毛细管的电压。

显示毛细管的电流。

显示检测器类型。

显示冷冻剂液位。

注释: 绿色表示可接受的液位，黄色表示液位较低，红色表示冷冻剂已
空。如果图标为红色，系统将不会运行。

按钮

单击以打开 Trace View 窗口。

单击以将试剂和样本孔板移动到初始位置。

单击以停止任何直接控制功能。

注释: 此按钮不会停止运行。要停止运行，在 Run Samples 窗口中，单

击  (Abort)。

Waters Empower™ 软件中的直接控制
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直接控制：System Status 选项卡

图 4-3 System Status 选项卡

标签 描述

Cartridge

Status 显示卡盒的状态。

Type 显示卡盒的类型。

Load 或 Eject 单击以锁定或弹出卡盒。

Transport

Sample Plate 显示样本孔板的位置。

Load 或 Eject 单击以加载或弹出样本孔板。

Reagent Plate 显示试剂孔板的位置。

Load 或 Eject 单击以加载或弹出试剂孔板。

Light Source

UV Lamp 显示紫外线灯的状态。

Turn On 或 Turn Off 单击以打开或关闭灯。

注释: 灯打开之后，计时器将开始 30 分钟的倒计时，指示灯准
备就绪之前需要经过的时间。

LIF Laser 如果系统安装了 LIF 检测器，则显示激光的状态。

Turn On 或 Turn Off 单击以打开或关闭激光。

注释: 激光器打开之后，计时器将开始 15 分钟的倒计时，指示
灯准备就绪之前需要经过的时间。如果仪器上未安装 LIF 检测
系统，则 LIF 激光器按钮不可用。

Waters Empower™ 软件中的直接控制
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标签 描述

System Status 显示关于系统状态的信息。

Action Progress Status 在运行样本组方法时，显示仪器方法中的当前操作、已用时间
以及关于该操作的其他信息。

Method 在运行样本组方法时，显示仪器方法的名称。

直接控制：Rinse 选项卡

图 4-4 Rinse 选项卡

标签 描述

Pressure (psi) 键入压力值，单位为 psi。

Duration (minutes) 键入冲洗的持续时间，单位为分钟。

Plate 单击包含冲洗液的孔板。选项为 Sample 和 Reagent。

Column 单击包含冲洗液的列。选项为 1 至 12。

Accept 单击以开始冲洗操作。

Waters Empower™ 软件中的直接控制

BioPhase 8800 系统 适用于 BioPhase 8800 Driver for
Empower™ 用户
42/103

操作员指南
RUO-IDV-05-15014-ZH-A



直接控制：Inject 选项卡

图 4-5 Inject 选项卡

标签 描述

VOLTAGE 单击以选择电压进样。

Voltage (kV) 键入进样电压，单位为 kV。

Duration (seconds) 键入进样的持续时间，单位为秒。

Polarity 单击电压的极性。选项为 Normal 和 Reverse。

注释: 如果为进样选择了 PRESSURE，则 Polarity 未启用。

Plate 单击包含待进样样本的孔板。选项为 Sample 和 Reagent。

Column 单击包含待进样样本的列。选项为 1 至 12。

PRESSURE 单击以选择压力进样。

Pressure (psi) 键入进样压力，单位为 psi。

Accept 单击以开始进样。

Waters Empower™ 软件中的直接控制

操作员指南
RUO-IDV-05-15014-ZH-A

BioPhase 8800 系统 适用于 BioPhase 8800 Driver for
Empower™ 用户

43/103



直接控制：Separate 选项卡

图 4-6 Separate 选项卡

标签 描述

Voltage (kV) 键入电压，单位为 kV。

Duration (minutes) 键入分离的持续时间，单位为分钟。

Ramp Time (minutes) 键入梯度时间，单位为分钟。

Polarity 单击电压的极性。选项为 Normal 和 Reverse。

Plate 单击包含待分离溶液的孔板。选项为 Sample 和 Reagent。

注释: 如果清除了 With Pressure，则此选项不可用。

Column 单击包含待分离溶液的列。选项为 1 至 12。

Accept 单击以开始分离。

With Pressure 选择以在施加电压时对毛细管施加压力。

Pressure (psi) 键入压力，单位为 psi。

注释: 如果清除了 With Pressure，则此选项不可用。

Direction 触摸以选择压力的方向。选项为 Forward 和 Both。

注释: 如果清除了 With Pressure，则此选项不可用。

Waters Empower™ 软件中的直接控制
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直接控制：Temperature 选项卡

图 4-7 Temperature 选项卡

标签 描述

Sample Storage Temperature

Set to: 键入样本存储室的温度，单位为摄氏度。

Capillary Cartridge Temperature

Set to: 键入毛细管卡盒的温度，单位为摄氏度。

直接控制：Direct Settings 选项卡

图 4-8 Direct Settings 选项卡

Waters Empower™ 软件中的直接控制
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标签 描述

Maximum current limit
(μA)

键入电流限制，单位为 μA。所有毛细管的最大电流均为 600
μA。

Data Collection Rate (Hz) 从列表中选择数据采集速率，单位为 Hz。对于 UV 检测，选项
为 1、2、4 和 8。对于 LIF 检测，选项为 2、4、8 和 10。

注释: 使用较低的数据采集速率以降低基线噪声。如果没有足
够的点来准确识别峰，则使用较高的数据采集速率。

Peak Width @ 50% Height 键入预期最窄峰的估计半高全宽 (FWHM)，单位为秒。

PMT Gain 从列表中选择 PMT 增益的值。选项为 5、10、100 和 1000。

注释: 如果预计样本会有高强度荧光，则使用较低的值。如果
预计样本会有低强度荧光，则使用较高的值。

直接控制：Cartridge Info 选项卡

图 4-9 Cartridge Info 选项卡

标签 描述

Serial Number 显示卡盒序列号。

Lot Number 显示卡盒批号。

Capillary Type 显示毛细管类型。

Capillary Total Length 显示毛细管的总长度，单位为 cm。

Waters Empower™ 软件中的直接控制
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标签 描述

Capillary Length to
Detector

显示毛细管至检测器的长度，单位为 cm。

Capillary Internal
Diameter

显示毛细管至检测器的直径，单位为 µm。

Recorded Number of
Runs

显示记录的运行数量。

First Use Date 显示使用卡盒的第一个日期。

Expiration Date 显示卡盒到期日期。

直接控制：Wavelength Settings 选项卡

图 4-10 Wavelength Settings 选项卡

标签 描述

UV Lamp

Filter 1 Wavelength 显示第一个滤波器的波长，单位为 nm。

Filter 2 Wavelength 显示第二个滤波器的波长，单位为 nm。

Cumulative Use 显示灯的使用小时数。

LIF Laser

Excitation Wavelength 显示激发波长，单位为 nm。

Emission Wavelength 显示发射波长，单位为 nm。
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标签 描述

Cumulative Use 显示激光器的使用小时数。
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采集数据 5
数据采集由 Waters Empower™ 软件启动。

添加试剂组
1. 在 Waters Empower™ Software Project 窗口中，单击 BioPhase 8800 > BioPhase

Instrument Method Editor。

Method Editors for BioPhase System 软件打开，显示 Instrument Method Editor 工作
区。

2. 在功能区中，单击 ，然后单击 Reagent Editor。
试剂编辑器打开，显示 Reagent Set Configuration 选项卡。

3. 要向任一试剂表添加新试剂，请单击 。
新行随即显示在表中。

4. 在新行的 Name 列中，键入新试剂的名称。

5. 在新行的 Viscosity 列中，键入新试剂的粘度。

默认粘度为 0.89 厘泊。

注释: 要显示包含常见粘度值列表的工具提示，请将鼠标悬停在粘度值上。

6. 单击 Color 列，然后从列表中选择一种颜色。

提示! 选择试剂盒试剂盖的颜色。

7. 对于组中的每种附加试剂，请重复第 3 步至第 6 步。

8. （可选）单击  从表中删除试剂。

9. （可选）单击  将删除的试剂恢复到表中。

10. 如果显示 Validation 窗格，则单击该窗格以查看错误。单击错误以突出显示错误发生的位
置，然后进行必要的更改。

如果不存在错误，则不显示 Validation 窗格。

11. 保存试剂组。

a. 单击 SAVE AS。

注释: 如果存在错误，则 SAVE AS 按钮不可用。解决 Validation 窗格中的所有错误，
然后单击 SAVE AS。

b. 如果同一种颜色分配给了不同试剂，则会显示一条消息。如果颜色应当相同，则单击
Yes。
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当相同试剂（例如，水）存在不同名称（例如，“Water Dip 1”和“Water Dip 2”）时，
会出现此消息。

Save Reagent Set 对话框随即打开。

c. 在 Reagent Set 字段中键入名称。

d. 单击 Save，然后单击 OK 以确认保存的试剂组。

创建新仪器方法
仪器方法还可通过导入 BioPhase 软件方法来创建。请参阅以下章节：导入 BioPhase 软件方
法以创建仪器方法。

1. 在 Waters Empower™ Software Project 窗口中，单击 BioPhase 8800 > BioPhase
Method Editor。
Method Editors for BioPhase System 软件打开，显示 Instrument Method Editor 工作
区。

2. 单击 New Instrument Method。
Instrument Method Editor 打开，Method Settings 选项卡显示在最前。

3. 单击 Reagent Set 列表并选择试剂组。
随即填充 Inlet Reagents from Reagent Set 和 Outlet Reagents from Reagent Set 表格。

4. 键入或选择 Method Settings 字段中的信息。

5. 要构建方法，打开 Method Program 选项卡，然后将操作拖放到 Program 窗格。

可以创建三种类型的方法：

• 分离方法：包含进样操作的方法，用于采集样本的数据。

• 调节方法：不含进样操作的方法，用于在运行分离方法以采集数据之前调节毛细管。

• 关闭方法：不含进样操作的方法，用于清洁毛细管以保证卡盒的使用寿命，并关闭光
源。

提示! 要将操作添加到方法末尾，请双击该操作。使用右键菜单从 Program 窗格复制、粘
贴或删除操作。

图 5-1 Action 和 Program 窗格

6. 单击 Program 窗格中的操作，以在 Parameters 窗格中编辑操作参数。
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如果需要，可以向 Method Settings 选项卡上的 Inlet Reagents from Reagent Set 和
Outlet Reagents from Reagent Set 表格添加其他试剂。

注释: 任何更改都不会保存到试剂组。如果随后将使用新试剂，则创建新试剂组。请参阅
以下章节：添加试剂组。

7. 要编辑试剂在试剂孔板中的位置，请执行以下操作：

a. 打开 Reagent Plate Setup 选项卡。

b. 单击试剂的 Column，然后从列表中选择列。

每个列只能分配一种试剂。

8. 如果显示 Validation 窗格，则单击该窗格以查看错误。单击错误以突出显示错误发生的位
置，然后进行必要的更改。

如果不存在错误，则不显示 Validation 窗格。

9. 保存方法：

a. 单击 SAVE AS。

注释: 如果存在错误，则 SAVE AS 按钮不可用。解决 Validation 窗格中的所有错误，
然后单击 SAVE AS。

Save Instrument Method 对话框随即打开。

b. 在 Method Name 字段中键入一个名称。

注释: 方法名称必须唯一才能启用 Save 按钮。

c. （可选）在 Description 字段中键入该方法的描述。

d. 单击 Save，然后单击 OK 以确认保存的方法。

方法将保存到 Waters Empower™ 软件数据库中。

10. 在 Method Editors for BioPhase System 窗口中，单击关闭框，即右上角的 ×。
Method Editors for BioPhase System 软件关闭，显示 Project 窗口。

要在 Waters Empower™ 软件中使用仪器方法，请确保将该方法添加到方法集中。请参阅以下
章节：创建方法集。

导入 BioPhase 软件方法以创建仪器方法
使用下列步骤导入 BioPhase 软件方法，并创建可与 Waters Empower™ 软件配合使用的仪器
方法。

1. 在 Waters Empower™ Software Project 窗口中，单击 File > New Method > Instrument
Method。
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图 5-2 Select Desired Chromatography System 对话框

2. 单击要使用的系统，然后单击 OK。
Instrument Method Editor 打开。

3. 单击 Import，然后浏览到调节方法。
该方法在 Instrument Method Editor 窗口中打开，Method Settings 选项卡显示在最前。

注释: 此窗口为只读模式。如果需要更改方法，则保存仪器方法，然后在 Method Editors
for BioPhase System 软件中编辑该方法。请参阅文档《软件帮助》中的“编辑现有的仪器
方法”章节。

图 5-3 仪器方法编辑器中的 Method Settings 选项卡

4. （可选）打开 Method Program 选项卡以查看操作。
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5. 要查看操作的参数，单击表格中的行。
Parameters 窗格更新以显示参数。

图 5-4 仪器方法编辑器中的 Method Program 选项卡

6. 保存仪器方法。

a. 单击 File > Save with Method Set。
Save current Instrument Method 对话框随即打开。

b. 在 Name 字段中键入一个名称。

注释: 名称长度必须少于 30 个字符，可包含字母数字字符、空格以及特殊字符 @、_
和 %。虽然有些版本的 Waters Empower™ 软件可接受超过 30 个字符和其他特殊字
符，但是如果在 Method Editors for BioPhase System 软件中编辑该方法，这些字符
可能会产生问题。

c. （可选）单击 Method Comments 字段，然后键入信息。

d. 如果出现提示，在 Password 字段中，键入当前用户的 Waters Empower™ 软件密
码，然后单击 Save。

仪器方法和方法集保存到当前项目。

7. 单击 File > Exit。

注释: 导入方法后，Instrument Method Editor 窗口中的 Import 按钮不可用，除非关闭窗
口后再重新打开。

创建方法集
每种仪器方法都需要一个方法集。
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注释: 方法集还可包括处理、报告和导出方法。要创建这些方法，请参阅 Waters Empower™

软件随附的文档。

1. 在 Waters Empower™ Software Project 窗口中，单击 File > New Method > Method
Set。

2. 在消息中，单击 No。
Method Set Editor 窗口随即打开。

3. 在 Instrument Method 列表中，选择仪器方法。请勿进行任何其他更改。

图 5-5 Method Set Editor 窗口

4. 保存方法集。

a. 单击 File > Save。

b. 在 Name 字段中，键入方法集的名称。

c. （可选）在 Method Comments 字段中输入信息。

d. 如果出现提示，在 Password 字段中，键入当前用户的 Waters Empower™ 软件密
码，然后单击 Save。
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图 5-6 Save current method set 对话框

方法集将保存到当前项目。

创建样本组方法
样本组方法是用于发送到 BioPhase 8800 系统以进行数据采集的样本和相关方法集的列表。

注释: 样本组方法还可通过 Waters Empower™ 软件创建，但是只有 Method Editors for
BioPhase System 软件才能创建孔板布局并验证与 BioPhase 8800 系统配合使用的样本组方
法。

创建样本组方法

注释: 样本组方法需要方法集。请确保任何必需的仪器方法都是方法集的一部分。

样本组和方法集在样本组方法中的排列会影响数据采集的持续时间。请参阅以下章节：关于设
置样本组方法的提示。

1. 在 Waters Empower™ Software Run Samples 窗口中，单击 BioPhase 8800 >
BioPhase Sample Set Editor。

Method Editors for BioPhase System 软件打开，显示 Sample Set Method Editor 工作
区。

2. 单击 New Sample Set Method。
Sample Set Method Editor 打开，显示 Sample Plate Setup 选项卡。

采集数据

操作员指南
RUO-IDV-05-15014-ZH-A

BioPhase 8800 系统 适用于 BioPhase 8800 Driver for
Empower™ 用户

55/103



3. 在 Sample Set Summary 表的第一行中，单击 Method Set Name 单元格，然后选择合适
的调节方法。

4. 在 Sample Plate Layout 窗格中，选择要添加样本的孔。

• 单击单个孔。

• 要选择列中的所有孔，单击列编号。

图 5-7 Sample Plate Layout 窗格

Sample Plate Layout 更新以显示所选的孔。

5. 如果需要从样本组方法中删除孔，右键单击 Sample Set Summary 表中的行，然后选择
Delete Row。

要删除所有孔，单击 NEW，然后创建新样本组方法。

6. 向 Sample Set Summary 表中添加所需样本信息。在包含样本的行中，执行以下操作：

提示! 还可通过粘贴从 Excel 复制的信息来添加所需信息。单击 Plate/Well 单元格，然后
按下 Ctrl-V 以粘贴来自 Excel 的信息。复制的文本应包含孔、样本名称和方法集名称。如
果 Empower 数据库中不存在该方法集，则粘贴后样本组表中的方法集单元格为空。

a. 在 Sample Name 单元格中，键入样本的名称。

b. 单击 Method Set Name 单元格，然后从列表中选择适当的分离方法。

提示! 为第一个样本行选择方法后，右键单击并选择 Apply method to all samples
in column 以将该方法分配给该列中的所有样本。

7. 重复上一步，直到为所有样本分配了方法集。

8. 单击最后一行中的 Sample Set Method 单元格，并选择合适的关闭方法。
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图 5-8 Sample Set Summary 表

9. 如果显示 Validation 窗格，则单击该窗格以查看错误。单击错误以突出显示错误发生的位
置，然后进行必要的更改。

如果不存在错误，则不显示 Validation 窗格。

10. 保存样本组方法。

a. 单击 SAVE AS。

注释: 如果存在错误，则 SAVE AS 按钮不可用。解决 Validation 窗格中的所有错误，
然后单击 SAVE AS。

Save Sample Set 对话框随即打开。

b. 在 Sample Set Name 字段中键入名称。

注释: 名称长度必须少于 30 个字符，可包含字母数字字符、空格以及特殊字符 @、_
和 %。虽然有些版本的 Waters Empower™ 软件可接受超过 30 个字符和其他特殊字
符，但是如果在 Method Editors for BioPhase System 软件中编辑该方法，这些字符
可能会产生问题。

c. （可选）在 Description 字段中键入信息。

d. 单击 Save，然后单击 OK 以确认保存的方法。

样本组方法将保存到 Waters Empower™ 软件数据库中。

11. 要查看、保存或打印孔板布局：

a. 打开 Plate Layouts 选项卡。

b. （可选）单击 PRINT。
Print Preview 窗口随即打开。

c. 根据需要，单击相应的按钮打印或保存孔板布局。

请参阅文档《软件帮助系统》中的“Print Preview 对话框”章节。

d. 单击关闭框，即右上角的 ×。
Print Preview 对话框随即关闭。
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12. 在 Method Editors for BioPhase System 窗口中，单击关闭框，即右上角的 ×。
Method Editors for BioPhase System 软件关闭，显示 Run Samples 窗口。

关于设置样本组方法的提示

样本组方法中的样本顺序会影响运行次数，从而影响所需的时间。BioPhase 8800 系统设计为
可同时从所有八支毛细管采集数据，与分配给每个孔的方法集无关。如果为列中的每个孔分配
了不同的方法，将存在八个独立的运行。

采用下面的建议，以尽可能减少运行样本组方法所需的时间。

• 为了防止启动新运行，对相同列中使用相同方法集的样本进行分组。如果使用多个方法
集，则将使用相同方法集的样本放在相邻的孔中。

• 为了尽可能减少所需的样本量，不要为每个列分配多个方法集。

新运行的原因

如果当前样本孔存在以下情况，则会发生新运行：

• 处于孔板上不同的列中。

• 是与上一个运行相同的孔。

• 在上一个运行中的孔之前。例如，上一个样本孔是 D1，当前样本孔是 A1。

• 使用与上一个运行不同的方法集

下例演示了软件如何确定启动另一次运行的时间。它假定孔 A1 是样本组方法中的第一个孔。

1. 在任何调节之后，样本组方法都会指示 BioPhase 8800 系统从列 1 中的八个孔（孔 A1 至
孔 H1）进样，然后使用分配给孔 A1 的方法集采集数据。

2. 软件会保存孔 A1 的数据，并将孔 B1 至 H1 的数据保留在内存中。

3. 软件评估样本组方法中的下一个行。

• 如果孔是 B1，方法集：

• 与 A1 相同，则保存孔 B1 的数据，然后软件评估样本组方法中的下一个行。重复执
行此步骤，直到整个列中的所有数据都已保存，或者下一个孔包含不同的方法集。

• 与 A1 不同，则删除内存中的数据，并开始新运行。从列 1 中的所有八个孔进样。

• 如果孔不是 B1：

• 如果孔是 A1（重复进样），则删除内存中的数据，并开始新运行。从列 1 中的所有
八个孔进样。

• 如果孔不在列 1 中，方法集：

• 与 A1 相同，则保存内存中的数据，软件评估样本组方法中的下一个行。

• 与 A1 不同，则删除内存中的数据，并开始新运行。从列 1 中的所有八个孔进
样。

• 如果孔不在列 1 中，则删除内存中的数据，然后开始新运行。从该孔所在的列中的
所有八个孔进样。
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4. 运行完成后，软件会保存当前孔的数据。然后，它按前文所述方式评估样本组方法中的下
一个行，但孔是该列中的下一个孔，而非 B1。请参阅步骤：3。

准备 BioPhase 8800 系统
使用本节中的程序准备 BioPhase 8800 系统以采集数据。

本节中的程序假定系统已正确安装并初始化。

提示! 为了节省时间，在启动运行之前 30 分钟开启光源，以使其预热。

加载试剂入口和出口孔板

注释: 为防止出现气泡，切勿摇晃或用力混合缓冲剂。气泡可能会造成分离问题。

1. 按照试剂孔板布局将试剂添加到试剂入口和出口孔板。

使用下表中的体积。

注释: 对于出口孔板，确保倒角位于右上方，然后仅填充孔板左侧的孔。右侧的孔用于溢
流，必须保持为空。

表 5-1 试剂入口和出口孔板的试剂

孔板 试剂

入口孔板 800 µL/孔

出口孔板 • 每个孔 2.8 mL 试剂，用于分离或等待操作

• 每个孔 1.5 mL 的 CE Grade Water，用于废液位置

2. 在板上覆盖一层罩膜。

小心: 潜在的系统损坏。切勿使用加热孔板密封剂涂抹密封件。热量可能会损坏孔板表
面，从而导致压力系统出现问题。

注释: 只有来自 USA Scientific 的 X-Pierce 膜经过了验证。如果使用不同的膜，则在使用
之前进行测试。

3. 将孔板放进吊桶式转头，然后在 30 g 的条件下旋转 4 分钟。确保吊桶保持平衡。

小心: 潜在的错误结果。切勿将未通过旋转除去气泡的孔板装入系统。存在气泡可能会导
致分离失败。

4. 确保孔板中不存在气泡。如果存在气泡，则使用更高的相对离心力 (RCF) 再次旋转孔板。

对于试剂孔板，最大 RCF 为 1,000g。对于样本孔板，最大 RCF 为 375g。

5. 在前面板上，触摸 Eject Reagent。
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图 5-9 Eject Reagent 按钮

孔板室打开。

6. 撕去孔板上的罩膜。

小心: 潜在的系统损坏。取下罩膜之前，切勿将板装入系统。运行期间若存在罩膜，则可
能会损坏毛细管尖端。

7. 如果孔板室已包含试剂孔板，则将这些试剂孔板取出。

8. 对准试剂入口孔板中的凹槽与弹片，然后将孔板放进孔板托架中。请参阅图：图 2-6。

9. 确保试剂出口孔板的倒角位于左上方，然后将孔板放进孔板托架背面。请参阅图：图
2-7。

10. 触摸 Load Reagent。

图 5-10 Load Reagent 按钮

孔板室关闭。

加载样本入口和出口孔板

1. 按照样本孔板布局将样本添加到样本入口孔板中。

最小样本量为 50 µL。 最大样本量为 200 µL。

推荐的样本量因应用而变化。请参阅具体的应用指南。

2. 为了防止损坏毛细管，如果存在并非每个孔中都有样本的列，则向每个空孔中添加 100
µL 至 200 μL 样本缓冲剂。

如果某列中没有样本，则孔可以保留为空。

3. 按照样本孔板布局将试剂添加到样本出口孔板。

最大体积为 2.0 mL。

推荐体积因应用而变化。请参阅具体的应用指南。

注释: 对于出口孔板，确保倒角位于右上方，然后仅填充孔板左侧的孔。右侧的孔用于溢
流，必须保持为空。

4. 在板上覆盖一层罩膜。
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小心: 潜在的系统损坏。切勿使用加热孔板密封剂涂抹密封件。热量可能会损坏孔板表
面，从而导致压力系统出现问题。

注释: 只有来自 USA Scientific 的 X-Pierce 膜经过了验证。如果使用不同的膜，则在使用
之前进行测试。

5. 将孔板放进吊桶式转头，然后在 30 g 的条件下旋转 4 分钟。确保吊桶保持平衡。

小心: 潜在的错误结果。切勿将未通过旋转除去气泡的孔板装入系统。存在气泡可能会导
致分离失败。

6. 确保孔板中不存在气泡。如果存在气泡，则使用更高的相对离心力 (RCF) 再次旋转孔板。

对于试剂孔板，最大 RCF 为 1,000g。对于样本孔板，最大 RCF 为 375g。

7. 在前面板上，触摸 Eject Sample。

图 5-11 Eject Sample 按钮

孔板室打开。

8. 撕去孔板上的罩膜。

小心: 潜在的系统损坏。取下罩膜之前，切勿将板装入系统。运行期间若存在罩膜，则可
能会损坏毛细管尖端。

9. 如果孔板室已包含样本孔板，则将这些样本孔板取出。

10. 调整样本孔板的方向，使板上的对准槽口对准凸舌，然后将板放进板托架中。请参阅图：
图 2-5。

11. 调整样本出口孔板的方向，使倒角位于左上方，然后将板放进板托架背面。请参阅图：图
2-7。

12. 触摸 Load Sample。

图 5-12 Load Sample 按钮

孔板室关闭。
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检查毛细管卡盒

警告! 刺伤危险。卡盒要轻拿轻放。毛细管的尖端特别锋利。

小心: 潜在的系统损坏。切勿让分离凝胶或其他试剂在电极、毛细管端、卡盒密封垫或卡盒主
体上结晶。电解质盐晶体或沉淀会导致毛细管堵塞、压力密封不当、样本进样时发生错误、出
现电弧或漏电。

1. 使用之前检查电极、毛细管尖端、卡盒密封垫和卡盒主体接口。

2. 如果卡盒外部存在液体，则使用湿无绒实验室擦拭巾清洁卡盒。清洁之后，确保干燥卡
盒。

注释: 切勿使用肥皂或洗涤剂清洁卡盒。

3. 如果毛细管尖端堵塞，则执行此操作：

a. 使用 CE Grade Water 清洗毛细管入口。

b. 使用无绒实验室擦拭巾沿着朝外的方向小心地擦拭毛细管入口。

4. 使用放大镜检查毛细管窗口两侧。如果存在绒毛或其他颗粒，则使用电子级压缩空气快速
吹扫以将其除去。切勿使用水或其他液体清洁毛细管窗口。

小心: 潜在的系统损坏。切勿使用甲醇或丙酮等有机溶剂清洁毛细管窗口。有机溶剂会溶
解胶粘剂，毛细管窗口的残留物可能会影响检测器。

5. 用乙醇或异丙醇蘸湿无绒擦拭巾或棉签，然后擦拭芯片表面。安装卡盒之前晾干芯片。

安装卡盒

警告! 刺伤危险。卡盒要轻拿轻放。毛细管的尖端特别锋利。

警告! 夹手危险。当打开前面板时，注意不要把手指放在前面板左侧。

小心: 潜在的系统损坏。确保在系统中安装卡盒之前安装试剂板。否则可能会损坏卡盒。

1. 如果卡盒存放在冰箱中，则让卡盒平衡到室温大约 30 分钟，以防止在系统中发生冷凝。

2. 从湿化托盘中取出卡盒。

3. 使用一次性实验室擦拭巾擦干卡盒主体，以防止产生电弧。

4. 将卡盒底部翻转朝上。

5. 使用一次性无绒实验室擦拭巾非常轻地擦干毛细管和电极从卡盒中显露出来的区域。切勿
干扰密封垫。
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图 5-13 卡盒底部

项目 描述

1 出口孔板密封垫

2 入口孔板密封垫

6. 如果试剂孔板未安装到系统中，则安装它们。请参阅以下章节：加载试剂入口和出口孔
板。

7. 打开前面板，然后将卡盒放入系统。

8. 关闭前面板，然后触摸 EJECTED 以锁定卡盒。

图 5-14 EJECTED 按钮

如果超出了卡盒运行寿命，则会在前面板日志中添加警告消息。要查看警告消息，请触摸

前面板状态区域的 。该卡盒仍可使用，也可安装新卡盒。

采集数据

操作员指南
RUO-IDV-05-15014-ZH-A

BioPhase 8800 系统 适用于 BioPhase 8800 Driver for
Empower™ 用户

63/103



系统移动试剂孔板，使毛细管进入色谱柱 1 上方的位置，然后升高孔板，使毛细管末端浸
入 CE Grade Water。

9. 检查前面板上的冷冻剂液位。如有必要，向系统的加注口中添加冷冻剂。

请参阅以下章节：添加毛细管卡盒冷冻剂。

启动样本组方法
1. 装载卡盒和孔板。请参阅以下章节：准备 BioPhase 8800 系统。

2. 在 Waters Empower™ 软件 Project 窗口中，单击 Tools > Run Samples。

图 5-15 Select Desired Chromatography System 对话框

3. 单击要使用的系统，然后单击 OK。
Run Samples 窗口打开。

4. 配置孔板类型。

a. 单击 Edit > Plates。
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图 5-16 Define Plates for Sample Set Method 对话框

注释: 如果该对话框看上去不像上图，则清除 2790 Layout 复选框。

b. 单击 Plate Type Name 单元格，然后选择 ANSI-96well2mL。
对话框更新，显示孔板图片以及孔板定序模式的按钮。

c. 单击 Plate Layout Position 单元格，然后输入 1。

d. 单击  以指示运行过程中样本孔的检测顺序。

e. 单击 OK 保存更改，然后关闭对话框。

提示! 要永久配置孔板类型，单击 Customize > Defaults，然后单击 Plates，执行第 4.b
步至第 4.e 步，然后单击 OK。

在 Sample Set Method 表中，Vials 列的标题变成 Plate/Well。

5. 单击  (Load Sample Set)。
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图 5-17 Load Samples 对话框

6. 单击 Load using a previously created sample set method，然后单击 OK。

图 5-18 Open an existing sample set method 对话框

7. 单击列表中的样本组方法，然后单击 Open。
该样本组方法在 Samples 选项卡中打开。

8. （可选）将表格配置为仅显示与 BioPhase 8800 系统相关的列。

a. 单击右键，然后选择 Table Properties。
Table Properties 对话框打开。

b. 单击 Hide All，然后清除 Plate/Well、# of Injs、SampleName、Function 和
Method Set / Report or Export Method 的复选框。
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c. 单击 OK。

表格更新，以显示所选的列。

图 5-19 Samples 选项卡

9. 审核样本组方法。如果需要进行任何更改，则在 Method Editors for BioPhase System 软
件中编辑该方法。对仪器方法或方法集进行的任何更改都自动传播到样本组方法。

10. 在 Waters Empower™ Software Project 窗口中，单击  (Start)。
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图 5-20 Run Sample Set 对话框

11. 如有必要，编辑 Run Sample Set 对话框中的信息。

a. 如有必要，编辑 Name for this sample set 字段中的信息。

b. 单击 Shutdown Method，然后选择冲洗毛细管的仪器方法。

注释: 对于冲洗液，确保使用与正在使用的毛细管兼容的溶液。

如果系统在运行期间遇到错误，则会执行此仪器方法，然后停止运行。

c. 如有必要，选择 Do Not Run Shutdown Method During User Abort。

d. 单击 Run。

运行开始。在运行过程中，Sample Set Method 窗口中代表正在采集的样本的行中的文本
为红色。

小心: 潜在的数据丢失。切勿在运行期间从 BioPhase 8800 driver for Empower™ Direct
Control 窗格发起任何操作，即使系统处于闲置状态也不例外。任何操作都可能会干扰数
据采集。

在 Waters Empower™ 软件中监测运行
使用此程序监测样本组方法的进度，如有必要，还可将其暂停或停止。
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注释: Waters Empower™ 软件中的大部分窗格针对色谱法设计。使用下列步骤监测毛细管电泳
分离的进度，忽略 Time Remaining 和 Solvent Required 窗格中的信息。

1. 如果检测到问题，可单击  (Abort) 停止运行。

小心: 潜在的数据丢失。在保存了所有数据之前切勿停止运行。样本组方法出现在下一行
时，即已保存了数据。

注释: 切勿使用 Direct Control 窗格中的 Stop 按钮。该按钮仅作用于从 Direct Control 窗
格启动的功能。

图 5-21 Abort Options 对话框

小心: 潜在的系统损坏。如果运行停止，则在再次使用卡盒之前使用调节方法冲洗毛细
管。如果不冲洗毛细管，电解质盐晶体或沉淀会聚积并导致毛细管堵塞、压力密封不当、
样本进样时发生错误、出现电弧或漏电。

当运行结束时，Sample Set Method 窗口的所有行中的文本都为红色。

2. 要查看正在采集的数据，在 Direct Control 窗格中单击  (Monitor)。
Trace View 窗口打开，然后数据显示出来。
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图 5-22 Trace View 窗口

3. 如有必要，执行任何下述操作：

• 要查看电流、电压或压力，打开左上部相应的选项卡。

• 要查看包含所有毛细管的数据的单个图形，在左下部单击 Overlay。

• 要查看特定毛细管的数据，选择或清除窗口底部的复选框以选择感兴趣毛细管。

• 要查看迹线上任何点的时间和检测器值，单击迹线上的感兴趣位置。

• 要放大数据，确保选择了 Overlay，然后拖动以选择要缩放的区域。也可使用鼠标滚轮
进行缩放。

• 要使数据恢复到原始尺寸，在右下部单击 Reset Zoom。

• 要查看缩放图中的不同区域，右键单击 X 轴或 Y 轴，然后拖动。

4. 如有必要，在右下部单击 Auto Zero。
检测器信号设置为零。

5. 等到 Abort 按钮 ( ) 从红色变成绿色 ( )。
数据采集与所有数据都已保存的时间之间可能存在延迟。绿色按钮表示所有数据都已保存
的时间。

6. 按照要求处置样本和试剂。请参阅文档《应用指南》中的“废物处置”章节。

7. 根据需要储存卡盒。请参阅以下章节： 运行后储存卡盒。
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运行后储存卡盒

警告! 刺伤危险。卡盒要轻拿轻放。毛细管的尖端特别锋利。

储存卡盒三天以内

1. 如果样本组方法中未包括关闭方法，则使用该关闭方法清洁毛细管。

2. 将卡盒在系统中储存最多三天，并且毛细管端应浸入 CE Grade Water 中。

注释: 如果卡盒不使用的时间达到三小时或更久，则在执行分离之前应运行调节方法。

储存卡盒三天以上

1. 如果序列或样本组方法中未包括关闭方法，则使用该关闭方法清洁毛细管。

2. 在 BioPhase 8800 系统前面板的功能区中，触摸  (Loaded)，然后等待大约一
分钟。

等到冷冻剂回到冷冻剂储液瓶，然后再取出卡盒。

3. 从系统中取出卡盒，然后将其储存在 2 °C 至 8 °C 条件下，毛细管端应浸入 CE Grade
Water 中。

注释: 定期更换托盘中的 CE Grade Water，以免托盘中出现微生物生长。

储存后准备卡盒

• 如果卡盒未使用的时间超过一天，或者已长时间储存，则使用调节方法调节毛细管。

注释: 为了防止产生电弧，在将卡盒安装到系统中之前，小心地拭去电极和卡盒主体四周的水
分。
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维护 6
警告! 电离辐射危险、生物危害或有毒化学品危险。在清洁或维护质谱仪之前，
确定是否需要去污。如果系统使用了放射性物质、生物制剂或有毒化学品，则
在清洁或维护之前客户必须先消除系统污染。

清洁表面
溢出后或变脏时，请清洁系统的外表面。

所需材料

• 软布

1. 用一块柔软的湿布清洁系统表面。

2. 用一块柔软的干布擦拭掉表面上的水分。

添加毛细管卡盒冷冻剂

所需材料

• 毛细管卡盒冷冻剂 (PN 359976)

• 加注工具 (PN 144647)

1. 检查 BioPhase 8800 系统前面板上的冷冻剂液位。
如果卡盒冷冻剂液位为红色，则添加冷冻剂。

2. 向左移动面板，以便使用冷冻剂加注口。

3. 将加注工具连接到加注口。

4. 托起注射器末端，向注射器中缓慢注入冷冻剂，同时监控指示器，直到达到所需的填充液
位。

5. 让注射器排空。

6. 重复第 4 步和第 5 步，直到卡盒冷冻剂液位为绿色。
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图 6-1 冷冻剂加注口

项目 描述

1 冷冻剂加注口

清洁样本盖和孔板室盖
定期拆下并检查样本盖。如有必要，接着清洁样本盖和孔板室盖。

所需材料

• 湿布

• 干布

• （可选）实验室纸巾

1. 在前面板上，触摸 Eject Sample 或 Eject Reagent。
孔板室盖自动打开，以露出孔板室。

维护

操作员指南
RUO-IDV-05-15014-ZH-A

BioPhase 8800 系统 适用于 BioPhase 8800 Driver for
Empower™ 用户

73/103



图 6-2 孔板室打开

2. 如果安装了孔板，则将其取下。

3. 取下孔板室盖和样本盖。

a. 按下白色孔板室盖正面的凹槽，将其移离蓝色滑动门。

b. 向前拉孔板室盖，直到可以将其拆下。

样本盖位于孔板室盖中。

图 6-3 孔板室盖部分向前，凹槽以红色圈出

图 6-4 样本盖（上）和孔板室盖（下）

4. 使用湿布或实验室纸巾清洁样本盖下侧和孔板室盖。

5. 将样本盖安装在孔板室盖上，然后将两个盖安装在孔板室中。推按两个盖，直到其卡入到
位。
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图 6-5 孔板室中的凹槽，以红色圈出

6. 安装在第 1 步中拆下的孔板。

7. 在前面板上，触摸 Load Sample 或 Load Reagent。

安装 UV 滤波器
UV 检测器随附有两个滤波器： 220 nm 和 280 nm。如果需要不同的滤波器，可以更换一个或
两个滤波器。请参阅表格：表 7-1。

所需材料

• 过滤器

• 无粉手套

1. 在前面板上，执行以下操作：

a. 触摸 Direct Control 以打开 Direct Control 窗口。

b. 触摸 Wavelength Settings。

图 6-6 Wavelength Settings 按钮

c. 触摸 Replace Filter 以更换滤波器。如果未输入 UV Filter 1 和 UV Filter 2 值，则
Replace Filter 按钮不可用。
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触摸屏更新以显示图片和说明。

图 6-7 光室的检修门

2. 在系统上，按下左下角以解锁，并拉开光室的检修门。
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图 6-8 打开光室的检修门

小心: 潜在的数据丢失。请勿在运行期间打开光室的检修门。如果门打开，则电压系统和
光源将会关闭，且分离可能受到影响。

3. 拆下圆形盖和滤波器总成。

4. 逆时针转动翼形螺钉以将其松开，然后拆下滤波器总成。

维护

操作员指南
RUO-IDV-05-15014-ZH-A

BioPhase 8800 系统 适用于 BioPhase 8800 Driver for
Empower™ 用户

77/103



图 6-9 UV 滤波器总成

项目 描述

1 UV 滤波器 1

2 翼形螺钉

3 UV 滤波器 2

5. 安装滤波器总成。

6. 顺时针转动翼形螺钉以将其拧紧。

7. 安装圆形盖。

8. 关闭光室的检修门。

9. 在前面板上，触摸 Done。

10. 在前面板上，更新滤波器信息：

a. 键入 UV 滤波器 1 的 UV 波长和序列号。

b. 键入 UV 滤波器 2 的 UV 波长和序列号。

c. 触摸 Done。
UV 滤波器数据已更改成功。
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图 6-10 UV 滤波器总成已保存更改

安装紫外线灯
UV 检测器使用紫外线灯。如果基线噪声过高或灯不发光，则可能需要更换灯。

所需材料

• 紫外线灯

• 无粉手套

警告! 高温表面危险。更换灯前，使灯有时间充分冷却。灯热时会导致烫伤。

1. 在前面板上，执行以下操作：

a. 触摸 Direct Control 以打开 Direct Control 屏幕。

b. 触摸 Wavelength Settings。
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图 6-11 Wavelength Settings 按钮

c. 触摸 Replace UV Lamp 以更换紫外线灯。
窗口打开，显示图片和说明。

图 6-12 光室的检修门

2. 在仪器上，按下左下角以解锁，并拉开光室的检修门。
当检修门打开时，安全联锁装置会关闭灯的电源。

维护
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图 6-13 紫外线灯更换

项目 描述

1 灯插头

2 翼形螺钉

3. 等待灯冷却后再取下。

4. 按下连接器的侧蝶片以将其从面板断开。

5. 松开翼形固定螺钉，按下连接器锁片。

6. 拆下灯。

7. 安装新灯，对准销与凹槽。

8. 拧紧翼形固定螺钉。

9. 安装连接器。

10. 关闭光室的检修门。
当检修门关闭时，安全联锁装置会打开灯的电源。

11. 在前面板上，触摸 Done。
紫外线灯已更换成功。

维护

操作员指南
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图 6-14 紫外线灯已更换

12. 如有必要，触摸功能区的 UV Lamp 按钮。
灯电源接通，计时器将开始倒计时，以指示灯准备就绪之前需要经过的时间。

安装 LIF 检测器滤波器
LIF 检测器随附有两个滤波器：陷波滤波器阻挡波长为 488 nm 的光线，发射滤波器发出波长
为 520 nm 的光线。这些滤波器安装在滤波器底座上。如果需要新滤波器，则必须购买完整滤
波器底座。

所需材料

• 滤波器底座 (PN 5066941)

• 无粉手套

1. 在前面板上，执行以下操作：

a. 触摸 Direct Control 以打开 Direct Control 屏幕。

b. 触摸 Wavelength Settings。

维护
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图 6-15 Wavelength Settings 按钮

c. 触摸 LIF Wavelength。

d. 触摸 Replace Filter。
窗口打开，显示图片和说明。

图 6-16 光室的检修门

2. 在仪器上，按下左下角以解锁，并拉开光室的检修门。
当检修门打开时，安全联锁装置会关闭激光器的电源。

小心: 潜在的数据丢失。请勿在运行期间打开光室的检修门。如果门打开，则电压系统和
光源将会关闭，且分离可能受到影响。

维护

操作员指南
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图 6-17 拆卸 LIF 滤波器底座

3. 拆下滤波器和底座。

4. 安装新滤波器和底座。

图 6-18 LIF 滤波器底座

5. 触摸 Done。

6. 在前面板上，更新 LIF 滤波器信息：

维护
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a. 键入 LIF 发射滤波器的滤波器波长和序列号。

b. 触摸 Done。
LIF 滤波器已更换成功。

图 6-19 LIF 波长

更换保险丝

警告! 火灾危险或触电危险。更换保险丝前，关闭系统并将其从主电源断开。只能
使用正确类型和额定值的保险丝进行更换。如未遵循以上指南，可能会导致起
火、触电或仪器故障。

所需材料

• 10 A 250 V 保险丝，标记为 T10A250V

• 小号平头螺丝刀

1. 关闭系统。

2. 从主电源插座以及系统背面断开主电源电缆。

3. 使用小号平头螺丝刀拆下位于主电源电缆连接器上方的保险丝座。

4. 从保险丝座总成中拆下保险丝。

5. 将保险丝安装在保险丝座总成中，然后将该总成安装到系统中。

6. 将主电源电缆连接到系统背面以及主电源插座。

7. 打开系统。

8. 在 Windows 桌面上，打开 BioPhase 软件，然后登录软件。

9. 如果系统无法正常运行，或者保险丝再次熔断，则联系 sciex.com/request-support。

维护
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订购部件 7
• 通过下列任一种方式从 SCIEX 订购部件：

• 电话：(877) 740-2129，选项 1（免费电话，仅限于美国），或转到 sciex.com/contact-
us 以寻找本地办事处。

• 电子邮件：Sales.Americas@sciex.com

• 传真：(800) 343-1346

• 互联网：对于美国、英国和德国的客户，可从 store.sciex.com 订购。

卡盒和部件

部件编号 描述

359976 毛细管卡盒冷冻剂，450 mL

5080311 BioPhase 化学孔板套件（4 个样本孔板，4 个试剂孔板，8 个出
口孔板）

5080313 BioPhase 样本孔板（20 个）

5080314 BioPhase 试剂孔板（20 个）

5080315 BioPhase 出口孔板（20 个）

5080121 卡盒，8 根毛细管，长 30 cm，外径 360 µm，内径 50 µm，无
涂层熔融石英毛细管

5080119 卡盒，8 根毛细管，长 30 cm，外径 360 µm，中性毛细管

表 7-1 滤波器

部件编号 描述

5085153 包含 220 nm 和 280 nm 滤波器的 UV 滤波器总成

5066890 UV 滤波器，220 nm

5072643 UV 滤波器，280 nm

5085159 LIF 滤波器底座及 520 nm 滤波器

5085178 LIF 滤波器底座及 560 nm 滤波器

5085177 LIF 滤波器底座及 600 nm 滤波器

订购部件
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表 7-2 灯

部件编号 描述

5065163 氘灯

订购部件
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系统规格 A

仪器规格

尺寸（高 × 宽 × 深） 72 cm x 62 cm x 69 cm (28.2 英寸× 24.4 英寸× 27.2 英寸)

重量 90.9 kg（200 磅）

电气 电源要求：100 VAC 至 240 VAC，10 A，50 Hz 或 60 Hz，I 类

功耗：电源电压不得超过标称值的 10%

保险丝：

• T10 A

• 250 V

安装（电压）类别：类别 II

工作环境 海拔高度：  2,000 m (6,562 英尺)

湿度：在 30 °C 条件下 < 70%（无凝结）

温度：建议为 15 °C 至 30 °C（59 °F 至 86 °F）

最大散热 600 W (2,047 BTU/hr)，稳态条件下

最大声压 70 dB

1 m 处的最大声压：66 dB

检测器规格

UV 检测器规格

表 A-1 UV 检测器规格

可用滤波器 220 nm 和 280 nm

滤波器带宽 25 nm（标称）

UV 源 33 W 预对准氘灯

UV 源使用寿命 1,000 小时

（可选）LIF 检测器规格

系统规格
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表 A-2 LIF 检测器规格

基线漂移 < 0.2 RFU/hr

基线噪声 < 0.005 RFU（峰间）

动态范围（设置为 1,000
时）

> 104

默认滤波器 488 nm 陷波滤波器（用于阻挡激发波长）和 520 nm 带通滤波器

激光器 3 mW，488 nm 固态

激光器使用寿命 10,000 小时

RFU 范围 0 RFU 至 1,000 RFU

灵敏度 1 × 1011 M 荧光素钠，信噪比 > 2

光学系统的波长范围 激发：488 nm

检测：500 nm 至 750 nm（取决于滤波器）

孔板规格
本部分介绍如何配置液体处理系统以使用样本、试剂和出口孔板进行操作。

样本孔板规格

要配置液体处理系统以使用样本孔板进行操作，请使用下图中的尺寸。样本孔板符合 ANSI 实
验室自动化和筛选学会 (SLAS) 标准。

系统规格

操作员指南
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图 A-1 样本孔板尺寸

尺寸 值

左边缘至孔 A1 中央 14.38 mm

上边缘至孔 A1 中央 11.24 mm

基部的长度 127.76 mm

基部的宽度 85.48 mm

系统规格
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图 A-2 样本孔板的孔横截面尺寸

尺寸 值

孔深度 22.10 mm

开口处的孔大小 5.00 mm

孔间距 9.00 mm

图 A-3 样本孔板侧视图尺寸

尺寸 值

总高度 31.25 mm

试剂孔板规格

要配置液体处理系统以使用试剂孔板进行操作，请使用下图中的尺寸。

系统规格

操作员指南
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图 A-4 试剂孔板尺寸

尺寸 值

左边缘至孔 A1 中央 14.38 mm

上边缘至孔 A1 中央 11.24 mm

基部的长度 127.76 mm

基部的宽度 85.48 mm

图 A-5 试剂孔板的孔横截面尺寸

系统规格
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尺寸 值

孔深度 29.95 mm

开口处的孔大小 5.00 × 8.27 mm

孔间距 9.00 mm

图 A-6 试剂孔板侧视图尺寸

尺寸 值

总高度 31.25 mm

出口孔板规格

要配置液体处理系统以使用出口孔板进行操作，请使用下图中的尺寸。

图 A-7 出口孔板尺寸

系统规格

操作员指南
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尺寸 值

左边缘至第 1 列中央 14.38 mm

上边缘至孔的上边缘 7.11 mm

基部的长度 127.76 mm

基部的宽度 70.00 mm

图 A-8 出口孔板的孔横截面和侧截面尺寸

尺寸 值

孔深度 29.95 mm

开口处的孔大小 5.00 × 55.79 mm

孔间距 9.00 mm

图 A-9 出口孔板侧视图尺寸

尺寸 值

总高度 31.25 mm

系统规格
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符号词汇表 B
注释: 下表中并非所有符号都可用于每种仪器。

符号 描述

澳大利亚合规标志。表示产品符合澳大利亚通讯与媒体管理局
(ACMA) 的 EMC 要求。

交流电

A 安培（电流）

窒息危险

欧洲共同体授权代表

生物危害

CE 符合性标志

cCSAus 标志。显示加拿大和美国的电气安全认证标志。

目录编号

注意。有关潜在的危害信息，请查阅相关说明。

注释: 在 SCIEX 文档中，此符号表示人身伤害危险。

符号词汇表

操作员指南
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符号 描述

  

中国有害物质限制使用警示标签。电子信息产品含有一定量的有
毒或有害物质。中间数字是环境友好使用期 (EFUP) 日期，表示
产品可正常运行的日历年数。EFUP 期满后，必须立即回收该产
品。循环箭头表示产品可回收。标签或产品上的日期代码表示生
产日期。

中国有害物质限制使用徽标。设备中所含有毒有害物质或元素未
超过最高浓度值，该设备是一种可回收利用的环境友好型产品。

请查阅使用说明。

压碎危险

北美 TUV Rheinland 的 cTUVus 标志

数据矩阵符号，可使用条形码读取器扫描此符号以获得唯一设备
标识符 (UDI)

环境危害

以太网连接

爆炸危险

眼睛受伤危险

火灾危险

符号词汇表
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符号 描述

易燃化学危害

易碎

保险丝

Hz 赫兹

国际安全符号“小心，存在触电风险”(ISO 3864)，又称为高压符
号
如果必须拆下主盖，请联系 SCIEX 代表，以免触电。

高温表面危险

体外诊断设备

电离辐射危害

保持干燥

请勿淋雨

相对湿度不得超过 99%

保持直立

撕裂/切断危害

激光辐射危害

符号词汇表
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符号 描述

抬升危险

磁场危险

制造商

活动部件危险

起搏器危险。不能用于佩戴起搏器的患者。

夹手危险

压缩气体危险

保护接地导线

刺伤危险

活性化学危害

序列号

有毒化学品危害

符号词汇表
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符号 描述

系统运输和保存的适宜压力范围为 66 kPa 至 103 kPa 之间。

系统运输和保存的适宜压力范围为 75 kPa 至 101 kPa 之间。

在指定的最小 (min) 和最大 (max) 相对湿度（无冷凝）范围内运
输和储存系统。

在 –30 °C 至 +45 °C 温度范围内运输和储存系统。

在 –30 °C 至 +60 °C 温度范围内运输和储存系统。

USB 2.0 连接

USB 3.0 连接

紫外线辐射危险

英国合格评定标志

VA 伏安（视在功率）

V 伏特（电压）

WEEE。请勿将设备当作未分类城市废物来处置。环境危害

W 瓦特（功率）

符号词汇表

操作员指南
RUO-IDV-05-15014-ZH-A

BioPhase 8800 系统 适用于 BioPhase 8800 Driver for
Empower™ 用户

99/103



符号 描述

XXXX 年 XX 月 XX 日

生产日期

符号词汇表
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警告词汇表 C
注释: 如果任何用于识别组件的标签脱落，则请联系现场服务人员 (FSE)。

标签 翻译（如适用）

EN61326—1, EN61326—2-6, CLASS A,
GROUP 1, ISM EQUIPMENT

EN61326—1、EN61326—2-6、A 类、1
组、ISM 设备

FCC Compliance. This device complies with
Part 15 of the FCC Rules. Operation is
subject to the following two conditions: (1)
this device may not cause harmful
interference, and (2) this device must accept
any interference received, including
interference that may cause undesired
operation.

FCC 合规。本设备符合 FCC 规则第 15 部
分。设备操作必须具备以下两个条件：(1) 该
设备不会引起危害性干扰，并且 (2) 该设备必
须能够承受收到的任何干扰，包括可能造成
意外动作的干扰。

FOR RESEARCH USE ONLY. NOT FOR
USE IN DIAGNOSTIC PROCEDURES.

仅供研究使用。请勿用于诊断程序。

WARNING: Lifting Hazard.

FOUR PERSONS REQUIRED TO LIFT
THIS EQUIPMENT.

警告：抬升危险。

抬升该设备需要四人。

WARNING: NO USER SERVICEABLE
PARTS INSIDE. REFER SERVICING TO
QUALIFIED PERSONNEL.

警告：本设备内没有用户可维修的部件。维
修工作应由具有资质的人员完成。

注释: 请查阅使用说明。

WARNING: CANCER AND
REPRODUCTIVE HARM.

www.P65Warnings.ca.gov

警告：癌症和生殖系统伤害。

www.P65Warnings.ca.gov

警告词汇表
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联系我们

客户培训
• 北美地区：NA.CustomerTraining@sciex.com

• 欧洲：Europe.CustomerTraining@sciex.com

• 在欧盟与北美之外请访问 sciex.com/education

在线学习中心
• SCIEX Now Learning Hub

购买用品和试剂
在 store.sciex.com 上在线重新订购 SCIEX 用品和试剂。要建立订单，使用报价、订单确认或
发货单中的帐号。目前，美国、英国和德国的客户都可以访问在线商店，将来会拓展至其他国
家/地区。对于其他国家/地区的客户，请联系当地的 SCIEX 代表。

SCIEX 支持
SCIEX 及其代表在全球范围内设有经过系统培训的服务和技术专家。他们可以解答系统问题
或可能出现的任何技术问题。详情请访问 SCIEX 网站 sciex.com 或通过下述方式之一联系我
们：

• sciex.com/contact-us

• sciex.com/request-support

网络安全
有关 SCIEX 产品的最新网络安全指南，请访问 sciex.com/productsecurity。

文档
本版本的文档取代本文档的所有先前版本。

要查看本文档的电子版本，需要 Adobe Acrobat Reader。要下载最新版本，请转到 https://
get.adobe.com/reader。

要查找软件产品文档，请参阅软件随附的版本发行说明或软件安装指南。

要查找硬件产品文档，请参阅系统或组件随附的文档。

最新版本的文档可从 SCIEX 网站上获得，网址：sciex.com/customer-documents。
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注释: 如需免费获取本文档的印刷版本，请联系 sciex.com/contact-us。
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